
  
 

 

Crystal Reports XI Release 2 

Deploying Visual Studio .NET Applications 

Overview 
This document discusses the options for deploying Crystal Reports XI 
Release 2 .NET applications for use in Visual Studio .NET 2002 and 
Visual Studio .NET 2003. Specifically, merge modules and interactive 
install packages are discussed. 

NOTE If you are using Visual Studio .NET 2005, use the help that is installed with Crystal 
Reports XI Release 2 to deploy your applications. To access the help, in Visual Studio 
.NET 2005, complete these steps: 

1. On the Help menu, click Contents.  

2. Expand Crystal Reports XI Release 2 and then click Deployment. 

Refer to this link for more information about the Visual Studio .NET 2005 deployment 
options: 

http://support.businessobjects.com/documentation/product_guides/cr_net/vs_2005/
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Introduction 
Crystal Reports XI Release 2 extends the powerful reporting capability of 
Crystal Reports on the Microsoft .NET platform. You can use the Crystal 
Reports Designer in Visual Studio .NET (VS .NET) to create or modify 
Crystal reports.  

You have the option of storing the report locally or publishing it as a 
report web service on a web server. Depending on whether you have a 
Windows or web application, you can host the report using the 
Windows Form Viewer or the Web Forms Viewer, respectively. 

 

Distributing report files 

Embedding reports 
When reports are added to a VS .NET 2002 or 2003 application that 
contains embedded reports, they are added as embedded resources.  
That is, the report will be compiled into the assembly’s manifest and will 
not be loaded from a separate report (.rpt) file. 

NOTE Reports are not added as embedded resources in VS .NET 2005 web applications. 

 

Having reports as embedded resources allows .NET applications to be 
distributed and deployed without having to distribute report files 
separately. As a result, you are not required to deploy external report 
files with your applications, and end users cannot modify them.  

Manually adding reports 
When deploying applications that do not embed report files, the report 
files must be manually added to the setup projects. As a result, reports 
can be easily modified and redeployed without having to recompile and 
redeploy the entire assembly. However, strongly-typed report objects 
cannot be used in the application and the reports must be loaded from 
disk. 

To manually add a report to your application, complete these steps: 

1. 

2. 

3. 

After adding a report to a project, click the report in the .NET 
Solution Explorer window. 

In the Properties dialog box, change the Build Action property from 
Embedded Resource to None.   

Load reports from disk by specifying a file path using the Load 
method of the ReportDocument object. 
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Overview of deployment methods 
There are two options for deploying Crystal Reports XI runtime files:  

• Using merge modules 

• Using an interactive install (also known as a redistributable or server 
install) 

 
While both options install the same files, the method of deployment 
differs. If you wish to include Crystal Reports runtime files with the 
application install package, then use the merge modules option. If you 
wish to deploy the Crystal Reports runtime files to a server computer as 
a standalone task, then use the interactive install option. 

 

Deploying applications using merge modules 

Adding required components 
The components to add to setup projects for distributing and deploying 
Crystal Reports XI Release 2 applications include the following: 

• Crystal report files (.rpt) 

• Crystal Reports XI Release 2 merge modules 

 
Crystal Reports files (.rpt) 
Crystal Reports files (.rpt) also need to be distributed when a .NET 
application is deployed. How the report files are deployed depends on 
the need and architecture of the application. Refer to the previous section 
- Including Reports in .NET Applications - for details on deploying 
report files. 

Crystal Reports XI Release 2 merge modules 
The merge modules that need to be added to the setup project are 
installed with Crystal Reports XI Release 2 in the …\Program 
Files\Common Files\Merge Modules folder. Updated versions can also 
be downloaded from the Business Objects support site from the 
following location: 

http://support.businessobjects.com/fix/merge_modules.asp

Earlier versions of Crystal Reports required three or more merge 
modules to be included in a setup project in order to deploy reports. For 
Crystal Reports XI Release 2, only one merge module is required to be 
included, while another merge module is optional. 
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CrystalReports11_5_NET.msm (required) 

The CrystalReports11_5_NET.msm merge module contains viewer 
controls, .NET SDK assemblies, Report Application Server (RAS) SDK 
assemblies, report processing engine, and database and export 
components. This merge module is always required for deploying 
Crystal Reports XI Release 2 .NET applications. 

When you add CrystalReports11_5_NET.msm to a setup project, it 
exposes a Keycode property that must be set to a 23-digit alphanumeric 
license key. The license key is emailed to you after you register your 
product. After the key code has been added to your VS .NET system, you 
can find it on the Help menu by clicking About Microsoft Development 
Environment. The keycode is listed in the Installed Products list box.   

 

NOTE If the license key is not set for the CrystalReports11_5_NET.msm merge module, an error 
will occur when building the project. Also, if the setup project is installed on a target 
computer without specifying the correct license key for the merge module, various error 
messages will appear. Refer to the section Additional Resources for related knowledge 
base articles. 

 

CrystalReports11_5_maps.msm (optional) 

You would use this merge module if you are including geographic maps 
in your reports. This merge module installs the files required to display 
them.  

 

Customizing your installation 

With Crystal Reports XI Release 2 and Visual Studio .NET, the 
CrystalReports11_5_NET.msm merge module allows you to set the 
property values to install or not install certain database drivers, export 
drivers, as well as the crystalreportviewers115 IIS virtual directory. 

Database drivers 
1. Click CrystalReports11_5_NET.msm in your deployment project 

and expand MergeModuleProperties. Table 1 displays the list of 
properties that are used to install database drivers. 

2. Since by default, all database drivers are installed with 
CrystalReports11_5_NET.msm, set the property value of a specific 
driver to 0 to exclude it.  
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Property Name Description 

InstallACT Crystal Reports database driver for ACT 
databases. 

InstallBTRIEVE Crystal Reports database driver for 
Pervasive database. 

InstallCDO32 Crystal Data Object database driver. 
InstallCRDB_ADO Crystal Reports database driver for 

Microsoft ActiveX Data Objects/OLE DB. 
InstallCRDB_ADOPLUS Crystal Reports database driver for 

Microsoft ADO.NET. 
InstallCRDB_CDO Crystal Reports database driver for 

Crystal Data Object. 
InstallCRDB_COM Crystal Reports database driver for COM 

data provider. 
InstallCRDB_DATASET Crystal Reports database driver for 

DataSet provider. 
InstallCRDB_ODBC Crystal Reports database driver for 

ODBC. 
InstallCRDB_ORACLE Crystal Reports database driver for 

Oracle. 
InstallCRDB_QUERY Crystal Reports database driver for Query 

Data. 
InstallDAO Crystal Reports database driver for 

Microsoft Data Access Objects. 
InstallFIELDDEF Crystal Reports database driver for Field 

Definitions. 
InstallFILESYSTEM Crystal Reports database driver for File 

System data. 
InstallIBM_DB2 Crystal Reports database driver for DB2 

Server. 
InstallINFORMIX Crystal Reports database driver for 

Informix Online Server. 
InstallP2BBDE Crystal Reports database driver for 

IDAPI. 
InstallP2BXBSE Crystal Reports database driver for xBase. 
InstallP2IXBSE_DLL Crystal Reports physical database DLL for 

xBase. 
InstallP2SACL Crystal Reports database driver for Public 

Folder ACL. 
InstallP2SEVT Crystal Reports database driver for NT 

Event log. 
InstallP2SEXSR Crystal Reports database driver for 

Exchange Server Admin. 
InstallP2SMAPI Crystal Reports database driver for 

Exchange Folders and Address Book. 
InstallP2SMSIIS Crystal Reports database driver for IIS 
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Log Files. 
InstallP2SOUTLK Crystal Reports database driver for 

Outlook Data. 
InstallP2SREPL Crystal Reports database driver for 

Exchange Public Folder Replica. 
InstallP2STRACK Crystal Reports database driver for 

Exchange Server Message Tracking Logs. 
InstallP2SWBLG Crystal Reports database driver for Web 

Log Files. 
InstallSYBASE Crystal Reports database driver for 

Sybase. 

Table 1 – Properties Used to Install Database Drivers 

 

Export drivers 
1. Click CrystalReports11_5_NET.msm in your deployment project 

and expand MergeModuleProperties. Table 2 displays the list of 
properties that are used to install export drivers. 

2. Since by default, all export drivers are installed with 
CrystalReports11_5_NET.msm, set the property value of a specific 
driver to 0 to exclude it.  

 

Property Name Description 

InstallU2DMAPI Property to determine whether to install 
the export driver for MAPI Export Format. 

InstallU2DNOTES Property to determine whether to install 
the export driver for Lotus Notes Database 
Destination Export Format. 

InstallU2DVIM Property to determine whether to install 
the export driver for Lotus Notes Mail 
Export Format. 

InstallU2FCR Property to determine whether to install 
the export driver for Report Export Format. 

InstallU2FHTML Property to determine whether to install 
the export driver for HTML 4.0 Export 
Format. 

InstallU2ODBC Property to determine whether to install 
the export driver for ODBC Export Format. 

InstallU2FPDF Property to determine whether to install 
the export driver for PDF Export Format. 

InstallU2FREC Property to determine whether to install 
the export driver for Records Export 
Format. 
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InstallU2FRTF Property to determine whether to install 
the export driver for Rich Text (rtf) Export 
Format. 

InstallU2SEPV Property to determine whether to install 
the export driver for Separated Export 
Values Format. 

InstallU2FTEXT Property to determine whether to install 
the export driver for Text Export Format. 

InstallU2FXLS Property to determine whether to install 
the export driver for Excel Export Format. 

InstallU2FXML Property to determine whether to install 
the export driver for XML Export Format. 

Table 2 – Properties Used to Install Export Drivers 

 
crystalreportviewers115 IIS virtual directory  
1. Click CrystalReports11_5_NET.msm in your deployment project 

and expand MergeModuleProperties property. The 
InstallViewerVirtualDir property is used to control whether the 
crystalreportviewers115 virtual directory is installed. 

2. Since by default the crystalreportviewers115 IIS virtual directory is 
installed with CrystalReports11_5_Net.msm, set the property value 
to 0 to not install it. 

 

Distributing and/or installing runtime files 
.NET framework 
Since VS .NET projects rely on the .NET framework, the framework must 
also be distributed and/or installed on the target computer. Typically, 
when a setup project is created, the framework is excluded. Different 
merge modules are used depending on the version of the .NET 
framework to which you are deploying. For more information on the 
different ways in which to distribute the framework, refer to the 
following information: 

http://msdn.microsoft.com/netframework/downloads/updates/defaul
t.aspx

ADO.NET 
If any of your report files are based on ADO.NET dataset objects, you 
will need to include certain merge modules, depending on the version of 
VS .NET you are using (see Table 3). 
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VS .NET Version Merge Modules Relevant Files 

VS .NET 2002 VC_CRT.msm  

VC_User_CRT71_RTL_X
86_---.msm 

Msvcr70.dll 
Msvcp70.dll 

VS .NET 2003 VC_STL.msm 

VC_User_STL71_RTL_X8
6_--- .msm 

Msvcr71.dll 
Msvcp71.dll 

 

Table 3 – Merge Modules for ADO.NET 

The files from these merge modules must be available to the application 
by either placing them in the application folder (recommended) or in the 
system path. 

Creating deployment packages for web 
applications 
Before deploying your ASP.NET web application, ensure that you have a 
web application or web services application ready for deployment. To 
create a deployment package for your ASP.NET web application, 
complete these steps: 

1. Open your web application in VS .NET and on the View menu, click 
Solution Explorer.   

2. Right-click your web application, click Add, and then click New 
Project. The Add New Project dialog box appears. 

3. Click Setup and Deployment Projects, click Web Setup Project, and 
then click OK. 

4. In the Solution Explorer, right-click the web setup project, click Add, 
and then click Project Output. The Add Project Output Group 
dialog box appears. 

5. Choose the primary output and content files to add to your web 
setup project, and then click OK. When the Primary Output is added 
to the project, some detected dependencies are added. Ensure that 
the dotnetfxredist_x86_enu.msm and dotnetcrystalreports.msm 
dependencies are excluded. 

6. In the Solution Explorer, right-click the web setup project, click Add, 
and then click Merge Module. The Add Modules dialog box 
appears. 

7. Click the CrystalReports11_5_NET.msm merge module, add it to 
your project, and then click OK. 
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NOTE If you deploy a web application that uses an ADO.NET Dataset, you also need to include 
the two additional Microsoft merge modules listed in the Runtime files section. 

 

8. In your web setup project, click the CrystalReports11_5_NET.msm 
merge module to display the properties. 

9. Expand MergeModuleProperties and type a valid license key in the 
Keycode Properties dialog box. The license key is the 23-digit 
alphanumeric string that is located on your Crystal Reports CD.  

10. Customize your install by excluding unneeded database and export 
DLL files. For more information, refer to the section Customizing 
your installation. 

11. To build your web setup project, right-click your deployment 
package (websetup1) in the Solution Explorer and then click Build.  

 

You are now ready to deploy your ASP.NET web application. 

 

Creating deployment packages for Windows 
applications 
Before deploying your ASP.NET Windows application, ensure that you 
have a Windows application ready for deployment.  To deploy a 
Windows application, complete these steps: 

1. Open your Windows application in VS .NET and on the View menu, 
click Solution Explorer.   

2. Right-click your Windows application, click Add, and then click 
New Project. The Add New Project dialog box appears. 

3. Click Setup and Deployment Projects, click Web Setup Project, and 
then click OK. 

4. In the Solution Explorer, right-click the Windows application, click 
Add, and then click Project Output. The Add Project Output Group 
dialog box appears. 

5. Choose the primary output and content files to add to your web 
setup project, and then click OK. When the Primary Output is added 
to the project, some detected dependencies are added. Ensure that 
the dotnetfxredist_x86_enu.msm and dotnetcrystalreports.msm 
dependencies are excluded. 

6. In the Solution Explorer, right-click the Windows Setup project, click 
Add, and then click Merge Module. The Add Modules dialog box 
appears. 

7. Click the CrystalReports11_5_NET.msm merge module, add it to 
your project, and then click OK. 
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NOTE If you deploy a Windows application that uses an ADO.NET Dataset, you also need to 
include the two additional Microsoft merge modules listed in the Runtime section above. 

 

8. In your setup project, click the CrystalReports11_5_NET.msm merge 
module to display the properties. 

9. Expand MergeModuleProperties and type a valid license key in the 
Keycode Properties dialog box. The license key is the 23-digit 
alphanumeric string that is located on your Crystal Reports CD.  

10. To build your Setup project, right-click your deployment package 
(setup1) in the Solution Explorer and then click Build.  

 

You are now ready to deploy your ASP.NET Windows application. 

  

Deploying applications using interactive install 
You must have Crystal Reports XI Release 2 Developer Edition or 
Crystal Reports Server XI Release 2 in order to use the interactive install. 
When deploying a web application or deploying multiple Windows 
applications to the same computer, it is recommended that you install 
the dependency files separately.   

This Windows installer package, CrystalRedist115_x86.msi, is located in 
the …\Program Files\Microsoft Visual Studio 
8\SDK\v2.0\BootStrapper\Packages\CrystalReports folder. You may 
find the updated versions of the Crystal Reports XI Release 2 install 
package at this location: 

http://support.businessobjects.com/fix/merge_modules.asp

To perform an interactive install, complete these steps: 

1. Run the install (.msi) file on the deployment computer. 

2. Type your Crystal Reports XI Release 2 license key code when 
prompted. The license key code may be found by clicking About 
Microsoft Development Environment on the Help menu of Visual 
Studio .NET.  
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Additional Resources 
Knowledge Base Articles 

c2010681 - “Invalid or Missing KeycodeV2.dll”  

c2012716 - “Job Failed Because a Free License Could not be Obtained” 

c2011205 - “Err Msg:  “Cannot find keycodev2.dll or invalid keycode”  

Whitepapers 

Crystal Reports XI .NET Application Deployment 

http://support.businessobjects.com/communityCS/TechnicalPapers/cr
xi_net_deployment.pdf.asp

Troubleshooting Error Messages Related to the Keycodev2.dll Error Message 

http://support.businessobjects.com/communityCS/TechnicalPapers/cr
net_keycodev2.pdf.asp

.NET Product site 
http://www.businessobjects.com/products/reporting/crystalreports/n
et/default.asp 

Developer Zone 
http://www.businessobjects.com/products/dev_zone/default.asp  

Support Site 
http://support.businessobjects.com/search/

Sample Applications 
http://support.businessobjects.com/fix/samplescr.asp

Contacting Technical Support 
http://support.businessobjects.com/fix/contact.asp
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